
General Description

This is the printing software you've been looking for!    Stop wasting time trying to create labels and cards 
with other software! Labels, Cards & More is the easiest to use general purpose printing software 
available.    But don't think that means you have to miss out on features, just because it's easy to use.    
This program can print on anything from labels to index cards, tags, tickets and even full page displays.    
Works with any Windows compatible printer.    You'll be creating labels, cards and more in minutes!

Features include:

· NEW! Shadowed Text
· NEW! Backgrounds
· NEW! Enhanced alignment commands.
· NEW! Improved Card Expert
· NEW! Built in address book for mailing labels.
· NEW! Templates.
· Full Undo/Redo
· Label and graphic previews in file dialogs.
· Support for JPG, TIF, PNG, BMP, PCX and WMF clipart.
· WYSIWYG, Zoom, Grid, Print Preview, Metric/English units.
· Multi-line & Rotated Text, Lines, Boxes, Ellipses, Counters.
· Link text delimited data files for mail merge.
· Pre-defined layouts for labels, tickets, index cards, envelopes & more.
· Custom layouts to print on any format label, card, etc.
· Print any number of labels starting from any position on a page.
· Full color support for color printers with Print Preview
· Optional crops marks for cutting your own cards.
· Complete online help.



Frequently Asked Questions

General

Q. How do I change the properties of an object (color, font, alignment etc.)?
A. Select the object by choosing the selection tool and clicking inside the object, then choose Properties 

on the Edit menu.

Q. How do I delete an object?
A. Select the object by choosing the selection tool and clicking inside the object, then choose Delete on 

the Edit menu.

Q. When I use the Edit Current Layout command some of the settings are disabled.    How can I change 
the settings that are disabled?

A. The Edit Current Layout command effects the layout of the current card only.    Because the card is 
already created certain settings cannot be changed.    To change these settings by using the Edit 
Layouts command then creating a new card.    The new card will use the new layout, which includes 
the modified settings that are disabled after the card is created.

Q. How do I change the background?
A. Choose Background on the File menu.    You can select a WMF file (for best results) or any other 

graphic file as your background.    Backgrounds cannot be selected or modified like other objects.

Q. The background I selected only covers part of the card.    How can I make it cover the entire card?
A. Backgrounds are automatically stretched to fit within the margins.    Select Margins on the Alignment 

menu and set them to zero if you want the background to cover the entire card.

Printing

Q. When I print a sheet, the cards are not aligned correctly.    What should I do?
A. Because all printers are slightly different you may need to make minor adjustments to the card spacing 

in order to achieve the proper results.    You can adjust the spacing between the cards using the Edit 
Current Layout command on the File menu.    Make sure to use this command as opposed to the Edit 
Layouts command because the settings changed under Edit Layouts do not take effect until you create
a new card.

Q. When I print some text objects do not print on all the cards.    They display fine on the screen.    What’s 
wrong?

A. The most likely cause of this is that you have the Variable Text option selected for the text object that is
not printing and do not have a complete list of text specified for the object.    If you do not intend to 
specify different text for each card then un-check the variable text option.    You can check the variable 
text option by selecting the object and choosing Properties on the Edit menu.    The variable text option
is shown on the Text page.

Q. When I print some objects do not print at all.    They display fine on the screen.    What’s wrong?
A. Make sure you do not have the object’s extended style set to Non-printing.    You can check the 

extended style by selecting the object and choosing Properties on the Edit menu.    The extended style 
is show on the General page.

Q. I cannot move or size some of the objects in my card.    What’s wrong?
A. Make sure you do not have the object’s extended style set to Position and Size Locked.    You can 

check the extended style by selecting the object and choosing Properties on the Edit menu.    The 
extended style is show on the General page.



Q. My graphics are not printing at all or are printing partially.    What’s wrong?
A. See the known problem section below.

Graphics

Q. What graphic file formats are supported?
A. BMP, WMF, PCX, JPG, PNG and TIF formats are supported.    Additionally, any graphic you can copy 

to the clipboard as a DIB can be pasted into your card.

Q. When I add a graphic all I see on the screen is a box with an X in it.    How do I display the graphic on 
the screen?

A. Un-check the Show graphic placeholders option in the Configuration dialog box.

Q. How do I use a graphic file that is in an unsupported format?
A. To use a graphic file in an unsupported format, you must convert the file to one of the supported 

formats.    The easiest way to do this is to convert the graphic to a bitmap (BMP)    Most paint and 
desktop publishing programs allow you to save a graphic as a bitmap.

Q. When I insert several large graphic objects into my card and attempt to edit other objects in the card 
performance is very slow.    What can I do?

A. When several large graphics objects exist in a card Windows needs time to re-draw those objects each
time you modify the card.    To speed things up, check the Show graphic placeholders option in the 
Configuration dialog box.    This will cause all graphic objects to be drawn as a box with an X in it on 
the screen.    When you print the graphics will be printed normally.

Q. When I try to use the Acquire Image I always get an error.    What’s wrong?
A. To use the Acquire Image command you must have TWAIN drivers and source manager installed on 

your computer as well as a TWAIN compliant input device, such as a scanner or digital camera.    If 
TWAIN is not installed (or installed incorrectly) the Acquire Image command will fail.    See the known 
problem section below for more information.

Text Objects

Q. I have a text object that is centered or right justified on the screen but when I print it is not aligned 
correctly.    If seems to always be too far to the left.    What can I do to correct this?

A. The problem is most likely that you have the text justification set to Left (the default) while you are 
trying to either center or right justify the text.    Select the object by choosing the selection tool and 
clicking inside the object, then choose Properties on the Edit menu.    You can set the justification on 
the Text Properties page.

Q. How to I edit the text in a text object?
A. Select the object by choosing the selection tool and clicking inside the object, then choose Properties 

on the Edit menu.    You can edit the text on the Text page.

Q. How do I set the properties of a text object (rotation, font, color, alignment etc.)?
A. Select the object by choosing the selection tool and clicking inside the object, then choose Properties 

on the Edit menu.    You can edit the text properties on the Text Properties page.

Q. When I try to rotate a multi-line text field the text appears on a single line.    What am I doing wrong?
A. Nothing.    This is a limitation.    Only single line text objects can be rotated.    Multiple lines are print on 

a single line automatically.    Use separate single-line text objects if you need to rotate multiple lines of 
text.

Q. Some text objects appear cut off on the screen when I use the Zoom commands or edit the text.    How



can I fix this?
A. The size of a text object is determined by the size of the text included in the object when it is first 

created.    When you zoom in on the card, the round off can cause the first or last few pixels of the text 
object to appear cut off.    When you edit the text (specifically making it longer) the size of the object 
remains the same and the remainder of the text is cut off.    This will not effect printing in any way, you 
can manually make the text object bigger by re-sizing it so it displays entirely on the screen.

Known Problems

1. Some pictures inserted as OLE objects do not print correctly.    This problem is related to the way some 
OLE server applications render their output on the printer.

If you insert a picture using the Insert Object command on the Edit menu and have trouble printing just 
remove the OLE object and insert the picture using the graphic tool.    If the picture is in an 
unsupported format you may be able to select the OLE object, copy it to the clipboard then use the 
Paste Special command to paste the object in as a Bitmap.

2. Some TWAIN drivers and source manager software are notably buggy.    If you experience random 
lockups or other problems after (or during) using the Acquire Image command we suggest not using 
the command.



Quick Start

This section explains how to quickly create a new file and customize it to meet your needs.    The following
steps describe the basics of creating a file.    For more advanced techniques please see the individual 
topics in the on-line help.

STEP 1: Creating a New File

When you choose to create a new file, you will be presented with the Template Dialog Box.    The template
dialog box allows you to create a new file from a template, saving you the work of starting from a blank 
file.    Choose a template that best matches the file you have in mind.    If none of the templates are even 
close to what you want, you can choose to create a blank file and start from scratch.

See: The Template Dialog Box

STEP 2: Adding Objects

When you first create a new file it will either be blank or it will have the objects from the template you 
chose in the template dialog box.    In either case you will probably want to customize the file by adding 
new objects.

1.    Choose a tool from the toolbar or from the Tool menu.

*    The type of object that will be added depends on the tool you choose.

*    Do not choose the selection tool.    This tool is used for selecting objects that are already in the 
card.

2.    Press the left mouse button with the pointer in the design area where you want to insert the object.

3.    To insert Lines, Boxes and Circles drag your mouse to the opposite corner of the line, box or circle 
you are adding and release the mouse button.

To insert Graphic objects, release the mouse button, choose the graphic file to add and click OK.

To insert Text objects, release the mouse button, enter the text and click OK..

STEP 3: Moving Objects

No matter how carefully you add objects to your file, you’ll most likely need to move them around to 
achieve the desired look.

1.    Choose the selection    tool from the tool toolbar or from the Tool menu.

2.    Press the left mouse button with the cursor over the object.

3.    Move the mouse and drag the object to where you want it.

4.    Release the mouse button.



STEP 4: Editing an Object  ’  s Properties  

Once you have objects in your file you will probably want to change their properties.    Properties include 
colors, line size, text, font, size, rotation etc.

1.    Choose the selection    tool from the tool toolbar or from the Tool menu.

2.    Double click the left mouse button with the pointer over the object.    The Properties dialog box 
appears.

3.    Change the appropriate properties of the object and click OK.

STEP 5: Saving Your File

1.    Select File|Save

2.    Enter a file name for your file and choose the folder where you want to store your file.

3.    Click Save.

STEP 6: Printing

See Printing



Importing Business Cards

Select File|Import Business Card

You can import business cards created with Business Card Designer Plus (32-bit). If you upgraded to 
this product from BCDP you can use this command to preserve any work you already have.

To import a card created with Business Card Designer Plus (32-bit) perform the following steps:

1.    Select File|Import Business Card

2.    Select the file to import (It should have the extension BCO).

3.    Click Open.



Printing

Select File|Print

Before printing your file you can specify several parameters to customize how the file is printed as follows:

To print one or many cards perform the following steps:

1.    Select File|Print.

2.    Choose the starting position on the first sheet.
*    This feature is used to print on partially used sheets of labels.    For example, you can start printing 

on the 4th label by specifying 4 here.    Position is determined by counting from left to right, top to 
botton.

3.    Enter the number to print.
*    You can click the All in Linked File button to enter the number of records in a linked data file (if you 

have one).

4.    Click Ok.

Notes:

If your labels are not aligned correctly on the printout, use the Edit Current Layout command on 
the File menu to adjust the positioning. .    If you need to make adjustments you should enter the 
same values using the Edit Layouts command on the File menu so that all new labels you create 
will be aligned correctly without further adjustment.



The Template Dialog Box

Select File|New

Templates are pre-designed files that you can use as the basis for your design.    Some of the templates 
are ready to use and can be printed as is while others may require you to fill in missing information or 
change information to meet your needs.

If none of the templates are a good starting point for the design you want to create you can click the 
Advanced button to create a file directly from a layout definition.    This gives you more options as far as 
page layout is concerned and allows you to design your file from scratch.

To create a new file from a template using the Template Dialog Box perform the following steps:

1.    Select File|New

2.    Choose the category..

3.    Choose the template (notice the preview to the right).

4.    Click OK.

Also See:

The Layout Maintenance Dialog Box



Creating and Modifying Templates

Saving a File as a Template

A template is a special type of file that can be used with the Template dialog box.    You can save any file 
as a template using the Save As Template command.    This command works just like the Save command 
only it saves your file as a template instead of a normal card file.    Files saved as templates in one of the 
sub directories within the Template directory well be visible in the Template Dialog Box.

Modifying an Existing Template

You can open an existing template by using the Open command by choosing Templates In the list of file 
types.    Once a template is open you can modify it and use the Save command to save your changes.



The Layout Maintenance Dialog Box

File|Edit Layouts

The Layout Maintenance Dialog Box allows you to select an existing layout, create new layouts, edit 
existing layouts, re-arrange layout ordering and set the default layout.

Selecting an Existing Layout
To select an existing layout to base your file on perform the following steps:

1.    Select File|New.

2.    Select the layout.

3.    Selected the desired orientation, Normal (portrait) or Opposite (landscape).

4.    Click Ok.
*    A new (blank) file is created in the layout you selected.

Editing an Existing Layout
You may want to make minor adjustments to a layout if the alignment on your printer is incorrect.

To edit an existing layout perform the following steps:

1.    Select File|Edit Layouts or File|New (to create a new file at the same time).

2.    Select the layout you want to edit.

3.    Click Edit.

4.    Edit the layout properties to suit your needs. (See Entering a Layout)

5.    Click Ok.

Creating a New Layout
To create a new layout perform the following steps:

1.    Select File|Edit Layouts or File|New (to create a new file at the same time).

2.    Click Add.

3.    Enter the layout properties to suit your needs. (See Entering a Layout)

4. Click Ok.



Setting the Default Layout
The default layout is the layout that is initially selected when you enter the layout maintenance dialog box.

To set the default layout perform the following steps:

1.    Select File|Edit Layouts or File|New (to create a new label at the same time).

2.    Select the layout you want to be the default layout.

3.    Click the Set As Default button.

4.    Click Ok.

Re-arranging the Order of Layouts 
To move a layout up or down the layout list perform the following steps:

1.    Select the layout you want to move.

2.    Click he Up or Down button until the layout is in the proper position

3.    Click Ok.



Inserting DB Field Objects

Select Tool|DB Field

A DB Field is a reference to a field in a linked data file that contains records of information, such as 
names and addresses.    DB Fields are used primarily for creating mailing labels.    To create mailing labels
you would create a data file that contains the names and addresses of the people you want to create 
labels for. You can do this manually or by using the built in address book. (See Data Files for more 
information).    You then create a label that matches the layout of your label paper and insert    DB Fields 
for the name, address etc.    You can also add additional objects, such as graphics, to dress you label up.  
When you print your labels, the DB Fields are replaced with the names and addresses in the data file.

To insert a DB Field perform the following steps:

1.    Select Tool|DB Field.

2.    Click in the design area where you want to insert the DB field.

3.    Select the field.

*    If no fields are listed or you want to link the label to a different file you can use the Browse button 
to choose a linked file.

*    When a select a linked file you effect all DB fields that are in the label, not just the one you are 
editing when you link the file.

4.    Optionally use the Text Object Properties tab to set the text properties.

5.    Click OK.

Also See:

Data Files

Editing an Object  ’  s Properties  
DB Field Object Properties
Text Object Properties
General Object Properties



Data Files

To use DB Fields and the mail merge features you must create a data file that contains the information 
you want to link to your labels.    DB Fields allow you to create mailing labels, envelopes, etc.    Although 
DB Fields can be used for many other things, only mailing labels are covered here.    Techniques for other 
uses are similar.    For example you may have a database of ingredient labels for your cooking spices.    
You could just as easily create labels for them using a DB Field and entering the ingredient names in 
place people’s names.

Creating a Data File

The easiest way to create a data file is to use the built in address book.    You can enter the names and 
addresses of people you want to create mailing labels for in the address book then use the Export 
command in the address book to create a data file for selected people. Be sure to leave the Include field 
names on first line option checked so that the exported file is in the correct format.

If your contact database is in another program or database you can often use its “Export” command to 
create a comma delimited text file.    In this case you may need to manually add the first line containing 
the field names to the file (follow the format below).    To use another program’s features you will need to 
consult that program’s documentation.    Some programs may not offer these features.

Finally, you can create a data file entirely by hand.    Follow the format below.

Data File Format

The data file is a simple delimited text file with the first line defining the fields used in the file.    The format 
of the data file is as follows:

Example:    Comma delimited with Name, Company and 3 Address fields per record

,,"Name","Company","Address1","Address2","Address3"
"John Doe","Joe's Auto, Inc.","Suite 5A","111 Willy Lane","East Allentown PA 12345"
"Jane Doe","Jane's Collectibles","222 Lamb Lane","Billsburg NY 11756",""

.

.

.

Notes:

Note the two commas at the beginning of the first line.    The first specifies the character to be 
used as the delimiter, the second is the delimiter between the delimiter and the first field 
description.    (You can use any character here , | and TAB. are the most common).

The first line contains the delimiter followed by delimited fields that contain the field names. (This 
line MUST be the first line in the file, NO BLANK LINES BEFORE IT.)

The remaining lines contain the records.
DO NO LEAVE BLANK LINES BETWEEN RECORDS OR AT THE END OF THE FILE.

Each record must conform to the fields defined on the first line, but excess fields may be left out. 
(as in the second record in the example above)



There can be a maximum of 20 fields per data file.

The "" grouping characters are optional.    Most programs that export to a delimited text file will 
group the fields with "" characters.



DB Field Object Properties

The DB Field Object Properties tab contains options specific to DB Field objects.

Fields

Select the field name (make sure you have a linked file first).

Linked File

Displays the linked filename.    Use the Browse button to select a linked file.



Entering a Layout

The Layout dialog box allows you to enter the properties for a new layout or edit the properties of an 
existing layout.    The layout defines how a page is laid out.    For example, the standard business card 
layout is defined as follows:

Width: 3.5
Height: 2.0
Rows: 5
Columns: 2
Space between rows: 0
Space between columns: 0
Side Margin: 0.75
Top Margin: 0.50

This would produce a page arranged like this:

In this case there is no gap between the rows nor between the columns.    The shaded area represents 
the cards and the non shaded area represents the margins. 

When you create a new file based on this layout you will be given a 3.5 x 2.0 inch area to design.    When 
you print a full page, ten cards will be printed on the page, arranged as shown above.

To enter the properties for a layout perform the following steps:

1.    Enter the name of the layout.

2.    Enter the width and height of a single item.
*    The width and height but be at least 0.5 inch.

3.    Enter the number of rows and column on a page.

4.    Enter the top margin.

5.    Enter the side margin.

6.    Enter the spacing between columns

7.    Enter the spacing between rows

8.    Choose the type of marker you would like displayed.



*    A Marker is used to display a feature on the screen to help alignment.    For example, you can 
include a marker that marks the position of a pre-printed line, box or circle on your stock.    This 
helps you when positioning objects on screen so they line up with the pre-printed object on your 
stock when printed.    Markers are not printed.

9.    Enter the position of the marker so it matches that on the pre-printed stock.

10. Click OK.

Notes:

When entering layout properties note the following:

The layout should be entered in a portrait orientation.    That is, as if you are looking at the paper 
with the long side up and down.

The sum of the widths and spacing between columns should equal the width of the paper.

The sum of the heights and spacing between rows should equal the height of the paper.



Configuration

Select Options|Configuration

The configuration option opens a dialog box that contains three tabs.

The General Tab
The general options include the following:

1. Show graphic place holders.
Check this option if you use LARGE graphic objects that take time to display.
You won’t see the graphic on the screen, but display time will be much faster.

2. Prompt when deleting an object
Check this option to prompt before deleting an object from the.

3.Return to the select tool automatically
Check this option to automatically return to the select tool after you use the currently selected tool.    If
this option is not checked the currently selected tool remains selected until you select another.

4. Metric Units
Check this option to use metric units in dialogs by default and on the rulers.

5. Reduce graphics to 256 colors
Check this option to reduce graphics to 256 colors.
Checking this option will reduce the size of your file without reducing print quality in most cases.
If you are using high quality graphics and a high quality printer you may want to uncheck this option *.

*You should also have your display set to at least 16-bit color if you uncheck this option and want the 
graphics to display correctly on the screen.    Printer output is not effected by your display color 
settings.

The Grid Tab
The grid options include the following:

1. Grid Size
Enter the number of logical pixels between grid lines.

2. Show Grid
Check this option to display the grid on the screen.

3. Snap to Grid
Check this option to automatically align objects to the grid when they are inserted or moved.

Note:    The Show Grid option does not have to be check to use the grid.

The Print Tab



1. Print crop marks on boundaries
Check this option to print crop marks on the printout.
(For use as a guide when cutting your own stock.)

2. Set printer orientation automatically
Check this option to automatically switch the printer between portrait and landscape orientation.    The
orientation is determined by the layout of the page.

The ID Fields Tab
The edit controls on this page allow you to specify identification information to be used when inserting ID 
Fields.    By entering your information here you can easily insert it into your design without re-typing it 
each time.

The Folders Tab
The folders tab allows you to specify the starting folders to be used when choosing graphic files and when
opening and saving files.

If you leave these settings blank the current folder will be used.



Check this option to print crop marks on the printout.
(For use as a guide when cutting your own stock.)



Check this option to automatically switch the printer between portrait and landscape orientation.    The orientation is determined by 
the layout of the page.



Inserting Text Objects

Select Tool|Text

To insert a text object perform the following steps:

1.    Select Tool|Text.

2.    Click in the design area where you want to insert the text.

3.    Enter the text.

*    You can either specify a single piece of text or check the Specify variable text checkbox and use 
the Add button to create a list of text.

*    If you specify variable text you can use the Up and Down buttons to move an item within the list, 
the Change button to modify an item already in the list or the Delete button to remove an item from 
the list.

4.    Optionally use the Text Object Properties tab to set the text properties.

5.    Click OK.

Notes:

When you select the Specify variable text checkbox you make the text object variable.    Variable 
text objects allow you to specify different text for each item printed.    For example, if you are print 
10 business cards and would like a different name on each you can use a variable text object for 
the name.    You would add 10 items to the variable text list, one for each name, in the order you 
want them printed.    If you only add 9 items to the variable text list then the last business card 
would have no name printed on it.

Also See:

Editing an Object’s Properties
Text Object Properties
General Object Properties



Inserting Line Objects

Select Tool|Line

To insert a Line object perform the following steps:

1.    Select the Tool|Line.

2.    Click on the beginning of the line.

3.    Drag to the end of the line and release.

Also See:

Editing an Object’s Properties
Line Object Properties
General Object Properties

Notes:

If you hold the CTRL key while inserting a line object, the line will automatically snap to either the 
vertical or horizontal direction.    This lets you create straight lines very easily.



Inserting Box/Circle Objects

          

          

          

          

          

          

Select Tool|Box or Tool|Filled Box or 
Tool|Rounded Box or ToolRounded Filled Box or
Tool|Circle or Tool|Filled Circle

To insert a Box/Circle object perform the following steps:

1.    Select the appropriate tool.

2.    Click on the upper left corner.

3.    Drag to the lower right corner and release.

Also See:

Editing an Object’s Properties
Box/Cirlce Object Properties
General Object Properties



Inserting Graphic Objects

Select Mode|Graphic

To insert a Graphic object perform the following steps:

1.    Select the Graphic tool.

2.    Click in the design area at the position where you want to insert the graphic.

3.    Select the filename of the graphic file and click OK.
*    The supported graphic formats are BMP, PCX, WMF, TIF, JPG, PNG

If a graphic object is too large to fitl it will be automatically scaled.    The scaling is done in such a way to 
preserve the aspect ratio of the graphic object so that the object is not distorted.

When inserting a graphic object you should pay close attention to the following:
(Please note that these suggestions can greatly improve the quality of SOME graphics, but there are 
many situations where they may be unnecessary.    Don't think that the following (somewhat technical) 
suggestions need to be fully understood to successfully use this program.

1. Choose graphic objects with the resolution of the printer in mind.

When displayed on the screen, intricate graphics may appear distorted because the screen's resolution is
far less than the printer's resolution.    In general, a graphic that is displayed and printed, pixel for pixel, 
will appear much smaller on the printer.    This means that the graphic must be "stretched" to print with the
same dimensions as displayed on the screen.    What really matters is how the graphic looks on paper!    
For the best print quality, it's best to use graphics that are much larger than the desired size and scale 
them to the size you desire.    This way the graphic will contain enough information to print at the higher 
printer resolution without having to be stretched.

For example, if the printer has a resolution of 300 by 300 dpi (as most laser printers do) then a 300 by 
300 pixel graphic will print 1 inch by 1 inch at 100% scale.    On the screen the same graphic may be 
larger than the entire cardl at 100% scale. This program uses a virtual resolution of 100 by 100 dpi screen
resolution to provide WYSIWYG formatting, which means that the graphic will require 3 inches by 3 
inches    With this in mind, scaling the graphic to occupy 100 by 100 pixels on the screen (1 inch by 1 inch 
virtual, 33 1/3 % scale) will cause the graphic to be printed at exactly 300 by 300 dpi, utilizing 100% of the
printer's resolution capabilities and provide the ultimate print quality!    Now this may seem complicated 
but really it is not.    Just try to use graphics that are about the same size when printed 100% scale as the 
size on the screen you desire.

2.    Try to keep the aspect ratio (height / width) of the scaled object the same as the aspect ratio of
the unscaled object.

If the graphic contains lines on angles, changing the aspect ratio could cause the lines to appear jagged.   
It's always best the maintain the aspect ratio of any graphic object when sizing the object.    (Size the 
graphic by dragging a corner to change the height and width of a graphic together and maintain the 
aspect ratio.)



Also See:

Editing an Object’s Properties
Graphic Object Properties
General Object Properties

Sizing an Object



Inserting Counter Objects

Select Tool|Counter

To insert a counter object perform the following steps:

1.    Select Tool|Counter.

2.    Click in the design area where you want to insert the object.

3.    Enter the MINIMUM number of digits to be printed.

4.    Enter the starting number for the counter.

5.    Optionally use the Text Properties tab to set the text properties.

6.    Click Ok.

Also See:

Editing an Object’s Properties
Counter Object Properties
Text Object Properties
General Object Properties



Inserting Custom Field Objects

Select Tool|Custom Field

To insert a Custom Field object perform the following steps:

1.    Select Tool|Custom Field.

2.    Click in the design area where you want to insert the object.

3.    Select the Custom Field you want to insert.

4.    Optionally use the Text Properties tab to set the text properties.

5.    Click OK.

Also See:

Editing an Object’s Properties
Text Object Properties
General Object Properties

Notes:

Custom Fields are defined on the Custom Fields page under Configuration on the Options menu.

After a Custom Field is inserted it becomes a normal text object.



Acquiring an Image from a TWAIN Source

Select Edit|Aquire Image

In order to use this feature you must have a TWAIN compliant device installed correctly on your computer.
Examples of TWAIN devices are scanners and digital cameras.

The Acquire Image command allows you to render an image directly into your design from a TWAIN 
compliant device, such as a scanner or digital camera

To acquire an image perform the following steps:

1.    Select Edit|Acquire Image

2.    Follow the directions specific to the TWAIN device you have installed.

Notes:

If you have more than one TWAIN device installed you can use the Options|Select TWAIN Source 
command to select the TWAIN source to use.



Adding a Background

Select File|Background

A background is an image that is displayed in the background of your design.    The background you 
choose is stretched to fit the entire margin area (which is almost the entire design by default).    You can 
change the area the background occupies by changing the margins.

To add a background perform the following steps:

1.    Select File|Background

2.    Choose the background type (None, Standard or Other graphic)

3.    Click the Choose button to select your background file(unless you selected None in step 2).

3.    Click OK.

Notes:

To remove the background entirely follow the steps above and choose None in step 2 then click 
OK.

The Standard (WMF) background type work best because WMF graphics can be scaled smoothly.   
Other graphic files will work but may not produce optimal results.



Selecting Objects

Select Mode|Select

To select an object perform the following steps:

1.    Select the Selection tool. (Not necessary to select OLE objects)

2.    Click on the object you want to select.

When an object is selected a thin border is displayed around the object.    If the object can be sized, a set 
of eight "grapples" are displayed on each edge and on each corner.    You can click on any of these 
"grapples" to size the selected object.

Notes:

To select more than one object hold the SHIFT key down while selecting. 

An object must be selected before it can be edited or its properties changed.

For objects that overlap, the smallest object that contains the point of selection is selected.

When an object is selected, all applicable properties for that object become the current properties.
(For example, when a text object is selected, the object's Font, Rotation, Foreground and 
Background colors become the current properties.    The next object that you insert takes on these
properties as the default.

To select an embedded OLE object you need not select the Selection tool.    If you click the left 
mouse button within an OLE object it will be selected.    Double click to edit the OLE object.



Moving Objects

To move an object perform the following steps:

1.    Select the object(s) (See Selecting Objects)
2.    Click anywhere within the object's border and drag the object to where you want it.
3.    Release the mouse button.

Notes:

You must hold the SHIFT key down while dragging the mouse to move the entire selection if more 
than one object is selected.



Sizing an Object

To change the size of a Box, Circle, Graphic or OLE object perform the following steps:

1.    Select the object(s) (See Selecting Objects)

2.    Move the cursor over a grapple on one of the edges (left, right, top or bottom).
*    The cursor will change to a double arrow.

3.    Press the left mouse button.

4.    Drag the mouse to size the object.

5.    Release the mouse button to register the changes.

To change the height and width of the selected object at the same time perform the following steps:

1.    Select the object. (See Selecting an Object)

2.    Move the cursor a grapple on one of the corners of the object.
*    The cursor will change to a diagonal double arrow.

3.    Press the left mouse button.

4.    Drag the mouse to size the object.

5.    Release the mouse button to register the changes.

Also See:
General Object Properties

Notes:

It's best to use the latter sizing method with graphic objects that require the aspect ratio to be 
preserved.

You can also use the Fit to Margins command on the Alignment menu to automatically size an 
object so it entirely fills the area within the margins.



Changing the Level of an Object

Select Alignment|Bring to Front or Alignment|Send to Back

The level of an object defines the order in which it is printed.    For example, you may have a graphic 
object that you want to overlay with    text.    In this case you want the graphic to be printed first, then the 
text on top of it.

By default objects are printed in the order they are created.    To change an object’s level perform the 
following steps:

1.    Select the object(s) (See Selecting Objects)

2.    To make an object appear that it is at the lowest level (behind all other objects) use the Send to Back 
command.

To bring an object to the highest level (in front of all other objects) use the Bring to Front command.



Aligning Objects

Aligning objects can be done a variety of ways.    You can use the grid to align objects as they are placed 
into the design area or you can manually align objects to best suite your needs relative to the margins and
each other.

Relative Alignment
.

Select Alignment|Align

To align objects relative to each other and/or relative to the margins perform the following steps:

1.    Select the object(s) (See Selecting Objects)

2.    Select Alignment|Align

*    In the alignment dialog you can specify alignment criteria for both the horizontal and vertical 
directions.

To make alignment easier, the alignment toolbar allows you to quickly align selected objects.

The following commands apply to single objects and groups of objects:

Align the selected object or group with the left margin.

Center the selected object or group between the left and right margins.

Align the selected object or group with the right margin

Align the selected object or group with the top margin.

Center the selected object or group between the top and bottom margins.

Align the selected object or group with the bottom margin.

The following commands apply only to a selected group of objects:



Align the left sides of the selected objects with the left edge of the selected group.. 

Center the selected objects between the left and right edges of the selected group.

Align the right sides of the selected objects with the right edge of the selected group..

Space the selected objects evenly within the selected group horizontally.

Align the tops of the selected objects with the top of the selected group.

Center the selected objects between the top and bottom edges of the selected group.

Align the bottoms of the selected objects with the bottom edge of the selected group.

Space the selected objects evenly within the selected group vertically.

Alignment with the Grid

Objects can be aligned with the grid to give your design a uniformly spaced appearance.    If the Snap to 
Grid option is on, all objects are automatically aligned to the grid when inserted or moved.    If the Snap to 
Grid option is not on, objects can still be aligned to the grid using the Align Selected to Grid or Align All to 
Grid commands on the Alignment menu.

To align the selected objects with the grid perform the following steps:

1.    Select the object(s) (See Selecting Objects)
2.    Select Alignment|Align Selected to Grid

To align ALL objects to the grid perform the following steps:

1.    Select Alignment|Align All to Grid

Also See:
Adjusting the Margins



Cut, Copy and Paste Commands

          

          

The Cut, Copy and Paste Commands allow you to move objects to and from the clipboard.

Cut and Copy allow you to move objects to the clip board.
Cut removes the object from the file after copying it to the clipboard.
Paste allows you to copy an object from the clipboard in to a file.
Paste Special allows you to choose the format of the object on the clipboard to be inserted.

To Copy or Cut an object perform the following steps:

1.    Select the object(s) (See Selecting Objects)

2.    Select Edit|Cut or Edit|Copy.

To Paste an object in to the file perform the following steps:

1.    Select Edit|Paste. (See note below)

2.    The pasted object will appear in the top left corner of the design area.
*    It can now be treated like any other object in your file.

To Paste Special perform the following steps:

1.    Select Edit|Paste Special.

2.    Choose the object type to paste.

3.    Click OK.

Notes:

The Cut and Copy options are only available when an object is selected.
The Paste option is only available when an object is available on the clipboard.

Graphic objects are treated as DIBS (Device Independent Bitmaps) when being move between a 
file and the clipboard.    Be aware of this when trying to transfer bitmaps from other applications 
through the clipboard.





Editing an Object’s Properties

Select Edit|Properties

An object’s properties are what define the object’s look and behavior.    Size, color, line size, text and style
are examples of an object’s properties.    You can edit an object’s propeties as follows:

1.    Select the object(s) (See Selecting Objects)

2.    Select Edit|Properties

3.    Depending on the type of object selected, a set of properties will be displayed for the object.

Shortcut:    Double click the left mouse button on a selected object to edit it’s properties.

Also See:

General Object Properties
Text Object Properties
Box/Circle Object Properties
Line Object Properties
Graphic Object Properties



General Object Properties

The General Object Properties tab contains options that are common to all objects.

Size and Position

Left The position of the left edge of the object.
Top The position of the top edge of the object.
Width The width of the object.
Height The height of the object

Extended Style

Non-Printing checkbox

Check this checkbox to make the object non-printing.    Non-printing objected are displayed at resign 
time on the screen but are not printed on the printer.

Position and Size Locked checkbox

Check the checkbox to lock the position and size of the object on the screen.    This prevents the 
object from being moved or re-sized by mistake.



Text Object Properties

The Text Object Properties tab contains options specific to text objects.

Rotation

Select or enter the rotation of the text object in degrees (0-359).

Font
Click this button to select the text font.

Text Color Combo
Select the color of the text..

Shadow Color Combo
Select the color of the text background.

Style
Select the style.    Additional sub-styles and parameters may be available depending on which style is 
chosen.

Justification

Left Left justified text (default)
Center Centered text
Right Right justified text

Shadow

Enter the X and Y offsets for the shadow.    These values are used to draw a shadow behind your text in 
the color you choose in the Shadow Color combo.



Line Object Properties

The Line Object Properties tab contains options specific to line objects.

Line Size
Select the width of the line.

FG Color Combo
Select the color of the line.



Box/Circle Object Properties

The Box/Circle Object Properties tab contains options specific to box and circle objects.

Line Size
Select the width of the lines used to draw the object.

FG Color Combo
Select the foreground color of the object.
* This is the color of the lines used to draw a filled pr normal box or circle
* For shadow style objects this is the color of the shadow.

BG Color Combo
Select the color of the inside of a filled or chadow box or circle.

Style

Normal Transparent background.
Filled Filled background
Shadow Shadow



Graphic Object Properties

The Graphic Object Properties tab displayed properties specific to graphic objects.    It also allows you to 
rotate, mirror and crop the graphic.

Because graphic objects can be scaled in the design area, it is sometimes hard to tell what the actual size
of the graphic is in relation to what you see on the screen.    That is, the actual properties can be very 
different than the displayed properties of the graphic.    The graphic properties described below show the 
actual properties of the graphic and the actual and displayed aspect ratio.

Width and Height The actual width and height of the graphic.

Size The size of the graphic in bytes.

Colors The color depth of the graphic.

Aspect Ratio The actual and displayed aspect ratios.

Rotate
Click this button to rotate the graphic 90 degrees clockwise.

Mirror
Click this button to mirror the graphic along the vertical (y) axis.
(The mirror command is available for 256 color graphics.)

Crop
Click this button to crop the graphic.    Before cropping    you must select an area on the graphic to be 
cropped.    To select an area press the left mouse button down over the image at the upper left crop 
corner, move the mouse and release the mouse button at the lower right crop corner.



Counter Object Properties

The Counter Object Properties tab contains options specific to counter objects.

Minimum # of digits
Specifies the minimum number of digits to be displayed by the counter object.

For example, if you specify 3 digits then 1 will print as 001.and 1200 will print as 1200.

Start at
Specifies the starting number for the counter object.



Undoing and Redoing Changes

      

Select Edit|Undo or Edit|Redo

Use the Undo command to undo the last change you made.    Each time you Undo, one change will be 
undone in the exact reverse order they were made.

Use the Redo command to redo an undo you just made.



Zooming In and Out

      

Select View|Zoom In or View|Zoom Out

Use the Zoom commands to zoom in or out on the design area.



Adjusting the Margins

Select Alignment|Margins

The margins are used as an aid to aligning objects in the design area.    Objects can be placed outside of 
the margins.

To set the margins perform the following steps:

1.    Select Alignment|Margins.

2.    Enter the left, right, top and bottom margins.

3.    Click OK.

Notes:

Margin settings are saved with the file.    Each file can have its own margin settings.

Margins are used ONLY for design-time alignment.    They have nothing to do with printing.



The left of the selected object (in pixels).



The top of the selected object (in pixels).



The width of the selected object (in pixels).



The height of the selected object (in pixels).



Check this option make the selected object non-printing.
If checked the object will display on the screen but will not be printed.



Check this option to lock the selected objects size and position.



Style of the selected object.



Preview of what the select object will look like.



Line size for the selected object.



Normal style.



Filled style.



Shadow style.



Choose the foreground color.



Choose the background color



Text associated with the selected object.



List the variable text items.



Check this option to enable variable text.
Variable text allows you to specify different text for each card that is printed.



Click this button to add the text to the variable text list.



Click this button to change the selected item in the variable text list.



Click this button to delete the selected item in the variable text list.



Click this button to move the selected item in the variable text list up.



Click this button to move the selected item in the variable text list down.



Shows how the selected object will look.



Specify the rotation of the selected object.



Left justified    text.



Right justified text.



Centered text.



Choose the foreground color.



Choose the background color.



Choose the text style.



Choose additional options for the text.



Choose additional options for the text.



Choose additional options for the text.



Choose the outline thickness.



Choose the shadow offset (X)



Choose the shadow offset (Y)



Click this button to choose the font.



Specify the minimum number of digits to be displayed by the counter.



Specify the starting number for the counter..



Lists the available Custom fields.
These fields are specified on the Custom Fields page under Configuration on the Options menu.



Lists the available DB fields.
These fields vary depending on the linked text DB file.



Shows the file currently linked.



Click this button to select the linked file.



Shows how the graphic will look.



Actual width.



Actual height.



Actual aspect ratio.



Displayed aspect ratio.



Size of the graphic in bytes.



Color depth.



Click this button to rotate the graphic 90 degrees clockwise.



Click this button to mirror the graphic along the vertical (y) axis.
This command is only available for 256 color graphics.



Click this button to crop the graphic.    Before cropping    you must select an area on the graphic to be cropped.



Check this option if you use LARGE graphic objects that take a long time to display.    You won't see the graphic on the screen, but 
display time will be MUCH faster.



Check this option to prompt before deleting an object.



Check this option to return to the selection tool automatically.



Check this option to use metric units in dialogs by default and on the rulers.



Check this option to reduce graphics to 256 colors.
Checking this option will reduce the size of your file without reducing print quality in most cases.
If you are using high quality graphics and a high quality printer you may want to uncheck this option *.

*You should also have your display set to at least 16-bit color if you uncheck this option and want the graphics to display correctly on
the screen.    Printer output is not effected by your display color settings.



This specifies the size of the grid in logical units (100 logical units = 1 inch).



Check this option to display the grid in the design area.



Check this option to automatically align all objected to the grid when they are inserted.



Lists the Custom fields



Enter your text here.



Click this button to add the text to the custom fields list.



Click this button to delete the selected custom field.



Click this button to change the selected custom field.



The folder where you want to start when choosing a graphic file.



The folder where you want to start when opening and saving files.



Insert Object Dialog Box

The Insert Object Dialog Box allows you to create a new object or select an object from an existing file.   
You can choose to display the object in its native form or as an icon.    You can also create a link to an 
existing file.    The available types depend on the OLE2 compliant application your computer.

Creating a new object

To create a new object to insert into the document perform the following steps:

1. Check the Create New radio button.
2. Select the object type from the Object Type listbox.
3. Click Ok.

To Create an object from an existing file perform the following steps:

1. Check the Create from File radio button.
2. Enter the name of the file that contains the object or choose Browse.
3. Optionally check the Link checkbox to create a link to the object.
4. Click Ok.

In either case, you can optionally display the object or link as an icon by performing the following steps:

1. Select an object as explained above.
2. Check the Display As Icon checkbox.    (The default icon is displayed.)
3. Choose Change Icon to select a new icon..    



Paste Special Dialog Box

The Paste Special Dialog Box allows you to choose the format on an object to be inserted from the 
clipboard.    The available types depend on the type of object currently on the clipboard.

Pasting an Object

To paste on object into your document perform the following steps:

1. Check the Paste radio button to paste an actual object or check the Paste Link radio button to paste a 
link to the object.
2. Select the object type you would like the object pasted as from the As listbox.
3. Click Ok.

Whether you paste an object or a link, you can optionally display the object or link as an icon by 
performing the following steps:

1. Select an object as explained above.
2. Check the Display As Icon checkbox.    (The default icon is displayed.)
3. Choose Change Icon to select a new icon..    



Convert Dialog Box

The Convert Dialog Box allows you to convert an object to another type or activate an object as another 
type.    The available types depend on the type of object.

Converting an Object

To convert an object to another type perform the following steps:

1. Check the Convert To radio button.
2. Choose the object type from the Object Type listbox.
3. Click Ok.

To activate a object as another type of object perform the following steps:

1. Check the Activate As radio button.
2. Choose the object type from the Object Type listbox.
3. Click Ok.

You can optionally display the object or link as an icon by performing the following steps:

1. Select an object as explained above.
2. Check the Display As Icon checkbox.    (The default icon is displayed.)
3. Choose Change Icon to select a new icon..      



Links Dialog Box

The Links Dialog Box display the links in your document and allows you to do such things as update, 
change and break links.    It also allows you to specify whether or no the link is automatically updated.

To update a link click Update Now.
          - The link is updated to reflect the actual content of the source object.

To Break a Link click Break Link.
          - The link is removed from your document.

To change the source of a link click Change Source and select the new source file.
          - The link now points to a new object.

To open the source click Open Source.
          - The object is opened by the application that created it.

With any link you can specify whether is will be automatically updated or manually updated.
          - Check the Automatic radiobutton to have the link automatically updated.
          - Check the Manual radio button to    make the link update only when you explicitly update it.



Change Icon Dialog Box

The Change Icon Dialog Box allows you to specify the icon and label that will represent an object or a 
link to an object.    The default icon is the icon provides by the application that created the object.

To use the current icon check the Current radio button.
          - The icon remains unchanged.

To use the default icon check the Default radio button.
          - The icon changes to the default icon.

To select an icon from another file perform the following steps:

1. Check the From File radio button.
2. Enter the file that contains the desired icon or choose Browse.
3. Select the icon from the available list.
4. Click Ok.

Regardless of the icon chosen for an object or link, you can specify a label for the icon in the Label edit 
control.    The label is displayed under the icon in your document.



File Open Dialog Box

The File Open Dialog Box allows you to choose a file that contains an object.



Change Source Dialog Box

The Change Source Dialog Box allows you to select a new source for a link.



Choose Icon File Dialog Box

The Change Icon File Dialog Box allows you to choose a file from which to extract an icon to be 
displayed in place of an object.



Warranty and License Agreement

In the following agreement "software" refers to all files included with this distribution package.

Shareware Information

THIS PRODUCT IS NOT FREE SOFTWARE.    It is distributed as Shareware, which allows you to try it 
before you buy it.    You may evaluate this product for 30 days.    If you decide to continue using it, you 
are required to either register (purchase) it or remove it from your computer.

Shareware gives you the opportunity to fully evaluate a product before spending your hard earned money 
on it.    We're sure you will find this product to be an excellent piece of software so please be honest and 
register if you continue to use it.

REGISTERED USERS ENJOY:

· Full unlimited registered access.
· Elimination of introduction screens.
· Priority technical support.
· Access to additional add-ins.
· Free minor version updates.
· E-mail notification of new versions and products.
· Special offerings.
· And much more...

You may freely distribute the SHAREWARE version provided that 1) you distribute the original distribution 
package containing all the original files 2) it's clearly stated that the software is Shareware 3) no more 
than $5 is charged per copy (only to cover duplication costs if applicable).    If you are a vendor see the 
VENDOR.DOC file for more information.    VENDORS MUST BE GRANTED PERMISSION DIRECTLY 
FROM US BEFORE DISTRIBUTING THE SOFTWARE.

License Agreement

By installing this software you accept the following license agreement:

The software is considered "registered" once the author has received appropriate payment, the 
registration ID has been entered and the software no longer displays the reminder screens.

WHILE THE SOFTWARE IS UNREGISTERED:

You are granted a right to use the unregistered software for an evaluation period of 30 days.    If you 
continue to use the software after the evaluation period you are required to either register or remove the 
software from your computer.

ONCE THE SOFTWARE IS REGISTERED:

You are granted a non-exclusive right to use a single copy of the software on a single CPU.    You may not
distribute registered copies of the software or your registration information.

NO MATTER WHAT:

You may not rent, lease, sell, sub-license, assign, or otherwise transfer the software.    You may not 



reverse engineer, de-compile or disassemble the software.

The author retains title and all ownership rights to the software.    The software and documentation are 
copyrighted.    United States copyright law provides civil and criminal penalties for the unauthorized use, 
reproduction, distribution, and/or sale of copyrighted material.

Warranty

This software comes with the ultimate warranty.    You can try it, use it and test it for 30 days without 
spending a cent.    If you are satisfied with the software (as we hope you will be) then pay for it by 
registering and continue to use it.    If you are not satisfied, remove the software from your computer and 
owe nothing.

CAM DEVELOPMENT DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE WHETHER 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES 
ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED.    NEITHER CAM DEVELOPMENT NOR 
ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF 
THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF CAM 
DEVELOPMENT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS.    IN 
NO EVENT SHALL CAM DEVELOPMENT 'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE 
PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM,
THE PERSON USING THE SOFTWARE BEARS ALL RISKS AS TO THE QUALITY AND 
PERFORMANCE OF THE SOFTWARE.    SOME STATES DO NOT ALLOW THE EXCLUSION OF THE 
LIMIT OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU.    THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS 
OF THE STATE OF NEW YORK AND SHALL INURE TO THE BENEFIT OF CAM DEVELOPMENT AND 
ANY SUCCESSORS, ADMINISTRATORS, HEIRS AND ASSIGNS.    ANY ACTION OR PROCEEDING 
BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT OF OR RELATED TO THIS 
AGREEMENT SHALL BE BROUGHT ONLY IN A STATE OR FEDERAL COURT OF COMPETENT 
JURISDICTION LOCATED IN SUFFOLK COUNTY, NEW YORK.    THE PARTIES HEREBY CONSENT 
TO IN PERSONAM JURISDICTION OF SAID COURTS.



Registration, Upgrade and Contact Information

Registration

In order to continue using this software after the 30 day evaluation period you are required to register.    
Registration is the process of paying for the software and entitles you to support, the latest version and 
free minor version updates.    (See Upgrade Policy below) In addition, by registering you'll be doing your 
part to assure that we continue working hard at providing you with quality software at a very low price. 

REGISTERED USERS ENJOY:

· Full unlimited registered access.
· Elimination of introduction screens.
· Priority technical support.
· Access to additional add-ins.
· Free minor version updates.
· E-mail notification of new versions and products.
· Special offerings.
· And much more...

For information on how to register please click the How To Order button on the Shareware screen when 
you start the program. 

Version Upgrade Policy

All registered users are entitled to free updates to all minor versions of the major version for which they 
have registered.    For example, registered users of a product version 3.0 are entitled to all 3.X versions 
for free (when available).    For the free update simply obtain a copy of newer version, install it over your 
old version and use the same ID you received when registering.

This will not work when upgrading to a new major version.    Special pricing is available to registered users
for major version upgrades..    Please contact us for details.

Contacting CAM Development

For additional information, the latest versions and other goodies please visit:

http://www.camdevelopment.com

Send your questions, comments and suggestions to:

E-mail: sales@camdevelopment.com

Phone: Available to registered users.

Mail: CAM Development
P.O. Box 945
Bellport NY 11713-0945






